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Analyza sekvenacnich dat na ,,mélké” taxonomické urovni, rekonstrukce , Species tree”

l. Analyza haplotypl pomoci parsimonickych haplotyovych siti [TCS]
Il. sité NNet a detekce rodi¢ovstvi hybrid( a polyploid{ [Splitstree]
[l. rekonstrukce species tree pri incomplete lineage sorting [*BEAST]
V. Vizualizace gene trees ve species trees [PrimeTv]

V. Odhad hranice druhu [BEAST, R, Genie]

Analyza haplotypd pomoci parsimonickych haplotyovych siti v programu TCS

programy:
O TCS: http://darwin.uvigo.es/software/tcs.html

zdrojové alignmenty (fylogeneze druh( rodu Loricaria):
O loricaria_upr_TCS.phy

Konstrukce sité:
0 Spusténi programu kliknutim na soubor TCS1.21.jar (ve sloZzce TCS1.21)
0 Nastaveni analyzy kliknutim na ,Start New TCS Analysis”

=  File > Select NEXUS/PHYLIP Sequence file — vyberte poZadovany alighment

ve formatu Nexus nebo Phylip (sequential format)

= Nastaveni,connection limit” - zaskrtnutim ,Calculate 95% Connection Limit”

= Nastaveni ,connection Ilimit“ je tfeba optimalizovat

analyzovanych dat. Pro madlo divergované sekvence milzZeme pouZit
procentudlni nastaveni podobnosti sekvenci pomoci , Calculate 90% (-99%)
Connection Limit” ale pro divergovanéjsi data je nékdy nutné nastavit , Fix
Connection Limit at“ a doplnit maximalni pocet kroku pfi kterych se jesté dva

jedinci spoji. Pokud je limit pFilis nizky, vytvofi se siti nékolik.

= Vrozbalovacim menu niZe je moZné nastavit, jak ma byt naloZzeno s mezerami
v alignmentu (Gap) — vyzkousSejte postupné oboje nastaveni a porovnejte

vysledek.
= Spustte analyzu pomoci tladitka ,,RUN“

= Pokud data obsahuji pozice kddované IUPAC kddem, objevi se upozornéni .

potvrdte , 0k”

0 Po probéhnuti analyzy se objevi jedna nebo vice siti, které Ize rozprostfit do roviny
oznacenim jednoho z haplotypl a kliknutim na ,Tree>Tree down” (pfipadné Tree

up, left, right — dle potreby)

= Béhem analyzy program seskupi stejné haplotypy do jedné skupiny



= Frakvence haplotypll je pak zobrazena jako pomérna velikost jednotlivych
ovalu (Ctvercll) ve vysledném grafu
= Poklepanim na jednotlivé haplotypy ziskate informace o jejich rozsiteni mezi
analyzovanymi jedinci
0 Pokud se objevilo vice siti, které se prekryvaji, rozprostfete je pomoci mysi.
Pfenastavenim Connection limit na vice krokU Ize sité propojit.
0 Pro vyslednou editaci grafu je vyhodné graf exportovat ve formatu ,postscript”
pomoci File > Save Network as PostScript” a poté nacist v nékterém z grafickych
program0 (napf. Adobe lllustrator apod.)

1l Analyza sekvenci v programu SplitsTree za Gi¢elem detekce hybridi/polyploidt

Sestrojenim sité algoritmem neighbour-net lze vizualizovat konfliktni signdly v datasetu. Diky tomu ji
Ize vyuZit napt. pro detekci hybridnich jedinc(, allopolyploidl nebo rekombinantnich sekvenci. Pozor,
vyuzivaji se distancni metody (v zakladnim nastaveni program navic pouziva pouze nekorigované p-
distance) — jedna se o uZite¢cného pomocnika, ale v analyze sekvencénich dat tento program neni
plnohodnotnou nahradou parsimonickych nebo Bayesovskych pristupl tvorby fylogenetickych
strom(

* programy:
o Splitstree: (http://www.splitstree.org/

¢ zdrojové alignmenty (fylogeneze rodi v ramci ¢eledi Zingiberaceae):

o GAPDH_Alpinioids.nex
¢ Konstrukce sité

o vstupni format je NEXUS. File = Open (soubor s pfiponou *.nex), analyza probéhne
automaticky s defaultnim nastavenim (pro orientacni analyzu neni tfeba prenastavovat).

o z vysledné sité je moiné nékteré sekvence vyrazovat (pravy klik mysi — Exclude
selected taxa) — zkoumame jak se méni topologie sité. Vyrazené sekvence je mozné opét vratit
ptes Data > Restore All Taxa

o Obrazky je mozné snadno exportovat, napt. do pdf: (File = Export Image).

Hybridni (rekombinantni) sekvence/jedinci se obvykle objevuji jako spojnice mezi svymi nejblizsimi
pribuznymi, tj v jednom z roh{ kosoctverce (viz obrazek 1. nizZe).
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Obrazek 1. Analyza NeighbourNet zobrazujici hybridni plvod nékterych jedinci (Cervené
allopolyploidni jedinci, zelené pravdépodobni hybridi na diploidni Grovni).

1. Rekonstrukce species tree pfi incomplete lineage sorting v programu *BEAST

Pro rekonstrukci fylogenetického stromu reprezentujici ,skute¢né” vztahy mezi analyzovanymi druhy
(tj. species tree), namisto genealogickych strom( reprezentujicich pouze fylogenezi dané casti
genomu, jednoho lokusu (tj. gene trees), se vyuZiva nejCasteji analyz vyuZivajicich Bayesovskou
analyzu a koalescen¢ni modely speciace. Programy, které tyto analyzy pouZzivaji jsou napt. *BEAST
(soucast program BEAST od verze 1.6.1.) nebo BEST (soucast program MrBayes od verze 3.2). Oba
programy vyuzivaji podobna vstupni data — dva a vice alignment( reprezentujicic jednotlivé genové
genealogie (tj. “gene trees”) v Nexus formatu. Kazdy analyzovany druh by mél byt reprezentovan
alesponn dvéma jedinci, aby mohly byt odhadnuty parametry pro koalescen¢ni model. Oba
programy maji take podobné vychozi pfedpoklady (Incomplete lineage sorting/deep coalescence je
hlavni zdroj rozdili mezi topologiemi gene trees a species tree).

Vyhodou programu *BEAST je napf. grafické uZivatelské rozhrani a moznost nastaveni a sledovani
vice parametr( analyzy.



programy:
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(o}

(0}

BEAST: http://beast.bio.ed.ac.uk/Main Page
= Zahrnuje sérii pomocnych program(, které neinstalujeme, ale rovnou

spoustime pomoci soubor(:
= BEAUtivl.7.5.exe
= BEASTvl.7.5.exe
= TreeAnnotator v1.7.5.exe
= LogCombiner v1.7.5.exe
Tracer: http://tree.bio.ed.ac.uk/software/tracer/

=  Spoustime soubor Tracer v1.5.exe
FigTree: http://tree.bio.ed.ac.uk/software/figtree/

= Spoustime soubor FigTree v1.3.1.exe

zdrojové alignmenty (fylogeneze rodl z ¢eledi Zingiberaceae):
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(o}
(0}

GAPDH_Alpinioids.nex (nDNA)
CHS_Alpinioideae.nex (nDNA)
ITS_Alpinioids.nex (nrDNA)
matK_trnLF_Alpinioids.nex (coDNA)

Rekonstrukce species tree:

(o}

Otevieme program BEAUTI (BEAUti v1.7.5.exe) a nacteme vSechny vstupni soubory
pomoci File 2 Import Data. Mysi oznadime vSechny soubory a v zahlavi ostupné
klikdme na tlacitka “Unlink Subst. Models”, “Unlink Clock Models” a “Unlink Trees”,
¢imz zajistime, Ze kazdy dataset bude analyzovdn na zakladé vlastniho modelu.
V levém hornim rohu zaskrtneme policko “Use Species Tree ancestral reconstruction
(*BEAST) Heled & Drummond 2010“
Vyskoc¢i okno s nabidkou, jakym zplsobem chceme zadefinovat druhy (seskupit
jedince z kazdého druhu do jednoho OTU). M{zZeme druhy zadefinovat manualné
pomoci , Create a new trait” a klepnutim na , 0k”“.
V nasledujicim okné ke kazdému jedinci pfifadime jméno druhu (jméno druhu se tedy
opakuje, pokud analyzujeme dva a vice jednincli z daného druhu).
V zéloZce ,Sites” zaddme kazdému analyzovanému lokusu vlastni parametry pro
model evoluce DNA (které jsme si predtim pro kazdy lokus odhadli napf. pomoci
jModeltest).

= Napf. ,Substitution model“ — GTR, ,Base frequencies” — Estimated, ,Site

Heterogeneity Model“ — Gamma; ostatni nechame defaultné.
= Provedeme pro vSechny lokusy — preklikdvame v levém sloupci ,Substitution
Model“

V zdlozce ,Clocks” nastavime model pro molekularni hodiny pro kazdy lokus. Pfi
pilotnich analyzach muiZeme nechat defaultni nastaveni ,Strict clock” pro vSechny
lokusy. Pozdéji mlzeme zkusit i jiny model molekuldrnich hodin, napf. ,Lognormal
relaxed clock” a porovnat vysledky. Okénka ve sloupci ,Estimate” by méla byt
zaskrtnuta pro vsechny lokusy kromé prvniho, nebot mutaéni rate je pro prvni lokus



zafixovan (rate = 1.0), zatimco mutacni rate ostatnich lokust bude odhadnut
v zavislosti na prvnim lokusu. Ostatni nastaveni muze zGstat defaultné.
V zéloZce ,Trees” nastavujeme apriorni parametry pro odhad species tree a gene
trees. Nastaveni v oddilu ,Species Tree prior used to start all gene tree models”
mohou zlstat defaultni. V oddilu ,Tree Model” je tfeba pro kazdy lokus upresnit
v rolovacim menu ,Ploidy type“, zda se jednd o ,autosomal nuclear” (v pfipadé
jadernych genu) lokus, ¢i ,mitochondrial” (v pfipadé plastidovych genu). Ve stejném
oddilu mizZeme nastavit zplisob konstrukce pocatecniho stromu na ,,UPGMA starting
tree”.
V zéloZce ,Priors“ zkontrolujeme, zda jsou vsechna nastaveni v pofadku (Cernym
pismem). Pokud jsou nékterd nastaveni cervené, je potfeba je rozkliknout a
odsouhlasit znovu defaultni nastaveni. Jedna se vétSinou o situaci, kdy chceme
odhadnout néjaky z parametri a mame velmi Siroké az nekonecné hranice (interval),
ve kterych parametr hleddme — nenastavili jsme vlastné zadnou apriorni informaci.
ProtoZe ale ,prior”“ nezname, musime nechat prohleddvat cely prostor moznosti.
V zéloZce ,,MCMC* nastavime parametry Bayesovské analyzy, tj.:
= pocet generaci, po ktery se bude prohledavat prostor moinych stromd —
zéleZi zejména na poctu analyzovanych vzorkl a mife nesourodosti
analyzovanych lokusi. Konecny pocet generaci je tedy potfeba optimalizovat
za pomoci kontroly pribéhu analyzy v programu Tracer (viz nize). Na poprvé
muUZeme nechat defaultni nastaveni, pokud analyzujeme napf. dataset do 30
jedinc. Jinak navySujeme.
= Do okénka ,File name stem” zaddame ndzev nasi analyzy, nejlépe s datem, kdy
analyzu provadime. Pfi kazdé dalsi analyze je dobré jméno analyzy
specifikovat, aby se nepletly vystupy jednotlivych analyz (log file apod.).
V pravém dolnim rohu klikneme na tlacitko ,Generate BEAST File“
Objevi se jesté jednou okno vyZadujici odsouhlaseni nastaveni ,priors“, odsouhlasime
,continue” a ulozime *.xml soubor do slozky, ve které chcete mit umistény vysledky
analyzy.

Otevieme program BEAST (BEAST v1.7.5.exe) a pomoci ,choose file“ vybereme dfive
vytvoreny *.xml file a spustime pomoci ,Run”.

= Prdbéh analyzy a jeji predpokladané ukonceni muizeme sledovat v nové

otevieném okné.

Pro kontrolu prabéhu analyzy miZeme (a je Zadouci) pouZit téZ program Tracer.
Otevieme soubor Tracer v1.5.exe a pomoci File 2 Import Trace file nacteme *.log
file z probihajici nebo jiz ukonéené analyzy programem BEAST. Po nacteni souboru
kontrolujeme zejména sloupec hodnot “ESS” v levé Casti okna. Pokud nékteré z Cisel
neni zobrazeno cerné (tj. ma hodnotu mensi nez 200), indikuje to, Ze analyza jesté
neprobéhla spravné (MCMC retézce nekonverguji). Pokud jsou ESS hodnoty mensi
nez 200 | po skonceni analyzy, je potfeba analyzu spustit znovu s nastavenim vyssiho
poctu generaci.
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Po skonceni analyzy vprogramu BEAST a kladném zhodnoceni jejiho priabéhu
v programu Tracer je potieba zkonstruovat konsensudlni species tree ze souboru
strom(l vytvorenych béhem analyzy pomoci programu TreeAnnotator.

Otevieme soubor TreeAnnotator v1.7.5.exe a do kolonky , Burnin® vepiseme, kolik
strom md byt odstranéno jako ,burnin“ faze. Obvykle pocitame ca 25% vsech
zaznamenanych strom0 (napf. pfi poctu 10 000 000 generaci a zaznamenani kazdého
1000 stromu vychazi burnin faze na 2500 strom(). Posterior probability limit
nastavime napf. na 0.9 a vySe. Do kolonky ,,Input Tree File” vybereme file se vSemi
zaznamenanymi species tree - najdeme ho mezi ostatnimi vystupnimi soubory
z analyzy BEAST a ma koncovku *.species.tree. Po kliknuti na ,,Choose file“ u kolonky
,Output file” se dostaneme do slozky s vystupnimi fily z analyzy a vytvofime zde novy
soubor pro vystupni strom, napf. s koncovkou *.species_cons.tree. Spustime analyzu
pomoci ,,Run”, ¢imz se vytvofi soubor s konsensualnim stromem.

Konsensudlni species tree se zaznamenanymi Posterior probability (statistickymi
podporami pro jednotlivé vétve) si miZzeme prohlédnout napf. v programu FigTree.
Hodnoty PP zobrazime Display = posterior v zaloZce ,,Node labels” v levé ¢asti okna.

Vizualizace gene trees ve species trees pomoci programu PrimeTv

Kdyz jsme ziskali hypotetickou topologii species tree, radi bychom se podivali na to, v jakych
aspektech se lisi jednotlivé gene trees od navrZeného species tree. Na zakladé pozorovanych rozdilli
se mlzZeme |épe rozhodnout, zda za odliShou topologii gene tree stoji spiSe tzv. Incomplete lineage
sorting (ancestralni polymorfismus), nebo jiné procesy. Jednim z program, ktery vykresluje topologii
gene tree do species tree je PrimeTV a to na zdkladé maximalné parsimonického pfistupu. Program
Ize stahnou z http://prime.sbc.su.se/primetv/ a instalovat, ale daleko pfijemnéjsi je webova verze

programu na http://prime.sbc.su.se/cgi-bin/primetv.cgi.
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programy:

PrimeTV: http://prime.sbc.su.se/cgi-bin/primetv.cgi

zdrojové soubory:

sp-tree-newick-prejmenovany.tre (Species tree druh( z rodu Curcuma)
cpDNA-kodovana-newick-prejmenovana.tre (jeden z gene trees — coDNA)

Pred vlastni analyzou je tfeba zkontrolovat pojmenovani koncovych OTU v obou stromech —
OTU ve species tree mlZeme ponechat jako jednoduché nazvy druhl (napf. Alismatifolia, bhatii,
apod), OTU v gene tree patfici k danému druhu by mély nést stejné jméno, jako ma druh ve
species tree, ale nebot téchto OTU bude vice, je potfeba je indexovat, nejlépe jednoduse pomoci
01_Alismatifolia, 02_Alismatifolia apod. Index pro jedince v gene tree bude tedy pred ,_“ a
jméno za ,_“ bude odpovidat jménu druhu ve species tree.

Rekoncilace genealogickych stromi do species tree:

Na strankach webového rozhrani programu vlozime do okna ,Species Tree” strom ze
souboru ,sp-tree-newick-prejmenovany.tre“ a do okna ,Gene Tree” strom ze



souboru ,,cpDNA-kodovana-newick-prejmenovana.tre“ a klikneme na , Automatic
reconcilation”

V nasledujicim okné zkontrolujeme, zda se jméne jedincli vgene tree spravné
prifadila jméndm druhi ve species tree a klikneme na ,,Reconcile and view”.

V poslednim okné si prohlédneme vysledek analyzy. Graf miZeme uloZit v nékolika
formatech, napf. ve formatu PostScript (*.ps), kteyry mizeme dale otevrit a editovat
v programech pro praci s grafikou (jako napt. Adobe lllustrator).

Postup zopakujeme pro vSechny gene trees, které mame k dispozici pro dany species
tree.

V grafickém programu lze nasledné zobrazcit vSechny gene trees v jediném species
tree dohromady.

Upozornéni - tato analyza je spiSe pomocnou vizualizaci sloZitych vztahl v rdmci species tree a je
treba si uvédomit, Ze napr. délky vétvi jednotlivych gene trees jsou v této analyze ingnorovany a
jejich délka je sekundarné odvozena, aby vyhovovala nejparsimonictéjSimu feseni. Je tedy dobré

napf. porovnat, zdali délky vétvi jednotlivych gene trees odvozené na zakladé koalescencni teorie

nejsou v piikrém rozporu s délkami vétvi naprzenych touto analyzou.

V. Odhad hranice druhti pomoci programti BEAST a Genie

General mixedYule-coalescent model - GMYC

e programy:

(o}
(o}
(o}
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BEAST (http://tree.bio.ed.ac.uk/software/)

FigTree (http://tree.bio.ed.ac.uk/software/)

R (http://www.r-project.org/)

Genie (http://evolve.zoo.ox.ac.uk/evolve/Genie.html)

e zdrojové alignmenty (krypticka diverzita zelené fasy Klebsormidium):

(0}

Kleb.nex (alignment obsahuje i shodné sekvence)

e vytvoreni time-calibrated fylogenetického stromu v programu BEAST

(0}

BEAUti — nacteni nexus formatu se sekvencemi (tlacitko +)

= Data Partitions—pokud alignment obsahuje rizné partitions (je nutné je
definovat na konci nexus souboru prikazem beginassumptions;
nasledovanymi jednotlivymi partitions: charset XX = 1-100, ...), pak zvolit
Lunlingsubstitutionmodels” (pro kazdou partition zvlast)

= SiteModels — nastaveni substitu¢nich model(

= ClockModels — nastaveni mutacnich rychlosti, zadat , estimate”, vybrat
Relaxedclock: Uncorrelatedlognormal model

= Trees — vybrat tree prior: Speciation: YuleProcess, Startingtree: UPGMA
generated

=  Priors — vybrat uniform prior pro ¢ervené oznacené radky

=  MCMC - 10 mil. generaci, Echo state — 10000, Log parameter — 1000
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= Generate BEAST file — OK...
BEAST
= ChooseFile — vybrat vygenerovany xml soubor, Run. Je moZné pomoci
BEAGLE zaradit vice procesor(
Tracer (zobrazeni hustoty pravdépodobnosti v MCMC)
= tlacitkem + otevtit .logfile MCMC analyzy (estimates ukaZe rozdéleni dat)
= podle grafu na karté ,Trace” nastavit burn-in
TreeAnnotator (analyzuje stromy vytvorené MCMC analyzou)
= nastavit burnin (100x mensi ¢islo neZ je uvedeno v Traceru), PP limit = 0.5
= zvolittreesfile z vystupu MCMC (.trees), zvolit jméno output file
FigTree
= nakreslit vysledny stromecek



e GMYC model
0 R (je potfeba mit nainstalovanou package ,ape”)
= pocita se pomoci package ,splits“ — viz ndvod zde:
http://barralab.bio.ic.ac.uk/downloads.html
= pouZit R script ,GMYC.R":

install.packages("splits",repos="http://R-Forge.R-project.org")
library(splits)

my_tree<-read.nexus('klebs_output.tre')

plot(my_tree)

test<-gmyc(my_tree, method = "single", interval = c(0, 5), quiet =
FALSE)

summary(test)
spec.list(test)

plot(test)

= vysledkem analyzy je:
e test modelu (LR = likelihood ratio test), neboli signifikantniho rozdilu
ve vétveni stromu na hranici druht
e pocet klastr (tj. druh()
e konfidenéni interval poctu klastrt
e seznam vsech sekvenci a jejich zarazeni do klastr(
o grafické vystupy (strom s vyznacenymi klastry, lineage-through-time
plot, likelihoodsurface)
e pro fajnsmekry: vytvoreni vlastihografulineage-through-time plot
0 Genie
= optimalné vytvofrit v PATH cestu k souboru GENIE.exe, spustit soubor ve
sloZce s uloZzenymi daty a dale jednoduchymi pfikazy vytvofit Itt plot:
= |oadXXX.tre (NEXUS tree vygenerovany v BEASTu pomoci TreeAnnotator)
= Jog soubor.log (vytvoreni logu)
= [ttXXX.tre (vytvoreni kfivky lineage-through-time)
= |og (zavreni logu)
0 log obsahuje data pro X, Y scatter plot, ten lze nakreslit v excelu, R, Statistice, ...



